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LAB SESSION 01 

OBJECT 

Demonstrating various components of a PC and their interconnection. 

THEORY 

COMPONENTS OF A PC 

System Unit 

It is the main computer system cabinet in a PC, which usually houses the power supply, 

motherboard, and some storage devices. 

 

Figure: 1.1: System Unit 
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Mother Board 

It is the main circuit board in a microprocessor system. It normally includes the microprocessor 

chip (or CPU), main memory (RAM) chips, all related support circuitry, and the expansion slots 

for plugging in additional components. It is also known as system board. 

 

Figure 1.2: Motherboard 
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Figure 1.3: Motherboard (Rear view) 

Read Only Memory (ROM) 

It is a type of memory in which instructions to perform operations critical to a computer are 

stored on integrated (chips) in permanent, non-volatile form. The instructions are normally 

recorded on the chips by the manufacturer. 

Random Access Memory (RAM) 

It is the name given to the integrated circuits (chips) that make up main memory, which provides 

volatile temporary storage of data and program instructions that the CPU is using; data and 

instructions can be retrieved at random, no matter where they are located in main memory. RAM 

is used for storing operating system software instructions and for temporary storage of 

applications software instructions, input data, and output data. 

On the basis of pin configuration, two types of RAM chips are available in the market: 

 SIMM – Single Inline Memory Module, all pins are aligned on one side of the chip. 

 DIMM – Dual Inline Memory Module, pins are aligned on both sides of the chip. 

On the basis of internal cell design, two types of RAM are there: 
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 DRAM – Dynamic Random Access Memory, made of capacitors, used for most main 

memories. 

 SRAM – Static Random Access Memory, made of flip flops, used for some specialized 

purposes within the main memory. 

 

Cache Memory 

It is a special high-speed memory area that the CPU can quickly access. It comprises a small area 

of RAM created in addition to the computer’s main memory (RAM); a copy of the most 

frequently used data and instructions is kept in the cache so the CPU can look in the cache first, 

which makes the computer run faster. Cache memory is usually located right on the 

microprocessor chip. 

Disk Drive                                                                                                                                                

Devices into which a diskette (floppy disk) or hard disk is placed for storing and retrieving data.    

 

Figure:1.4 Floppy Disk Drive 

Floppy Disk 

It is a thin plastic disk, also called diskette, which can be magnetically encoded with data, 31/2 

inches in diameter.  

 

Figure:1.5: Floppy Disk 
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Hard Disk 

It is a direct access secondary storage device consisting of a rigid metal platter connected to a 

control spindle; the entire unit, including the read/write heads, is enclosed in a permanently 

sealed container. Hard disks store much more data than diskettes do. 

 

Figure:1.6: Hard Disk 

Compact Disk 

It is an optical disk whose data is laser-recorded by the disk manufacturer. The user cannot 

change it or write on the disk, he can only read the data. 

Processor Chip 

It is an integrated circuit (chip) containing the CPU circuitry for a microprocessor. CPU is the 

brain of the computer; the part of the computer composed of electrical circuitry directing most of 

the computer system’s activities. It consists of the control unit and the arithmetic/logic unit 

(ALU) connected by a bus. 

Parallel Ports 

A parallel port is a socket on the system unit for attaching peripheral devices that transmit 8 bits 

simultaneously; used mainly for connecting printers. 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

9 
 

 

Figure 1.7 : Parallel Port 

Serial Ports 

A serial port is a socket on the system unit for connecting peripheral devices, such as a modem 

or a mouse, that transmit data serially, one bit after the other. 

 

                                                    Figure 1.8 : Serial Port 

System Clock/Timer 

Every microprocessor contains a system clock. It controls how fast all the operations within a 

computer take place. The faster the clock the faster the processing; clock speed in measured in 

megahertz. 

Power Supply 

It is the source of electrical power to components housed in the system unit of a PC. 
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Data Cables 

It is the communication path linking several devices to the microprocessor for transferring data. 

Power Cables 

It is the communication path linking several devices, including the microprocessor, to the power 

supply for provision of electrical power. 

     Figure 1.9: Power Cables    

Expansion Slots 

In a PC, an area within the system cabinet where expansion cards, such as color graphic adapter 

cards and expanded memory cards, can be inserted and plugged into the computer’s circuitry. 

 

Figure 1.10: Expansion Slots 
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Display Screens 

Color display screen is one that can display up to 16.7 million colors, depending on the type of 

display screen and graphics adapter cards used. 

Screens 

Video display screen is a device for viewing computer output. Two main types are: 

 Cathode ray tube (CRT) - also called monitor or screen. 

 Flat panel display - a type of display screen used on portable computers. They are much thinner, 

weigh less and use less power than CRTs. 

Graphic Adapter Cards 

Graphics adapter card, also known as video display adapter is a circuit board in the system unit 

that determines the display screen’s resolution, number of colors, and how fast images appear. 

The card and the monitor must be compatible models. These cards are the expansion cards 

plugged into expansion slot in system cabinet that allows compatible monitor to display bit-

mapped graphics. They must be used with appropriate software. 

Commonly used types of adapter cards are: 

Color graphics adapter (CGA) - displays 4 colors as well as monochrome images. 

Video graphics array (VGA) - displays 16 colors. 

 

 

Figure 1.11: VGA Card 

Super video graphics array (SVGA) - displays up to 256 colors at a very high resolution. 

Extended graphics array (XGA) - supports up to 16.7 million colors at a very high resolution. 
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Sound Cards 

Sound card is a circuit board in the system unit which helps producing sounds at the output 

devices. It plugs in to an expansion slot in the PC. 

 

Figure 1.12  : Sound Card 

Network Cards 

A network interface card, which is inserted into an expansion slot in a PC, enables the computer 

to send and receive messages on a LAN. 

 

Fig:1.13 Network Card 

Modem Cards 

Modem is a device for translating digital signals from a computer into analog signals for 

transmission over telephone lines and then back into digital signals again for processing, that is a 

modem must be hooked up at each end of the transmission. Modem stands for 

Modulatot/DEModulator 
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Figure:1.14 Modem Card 

Math Coprocessor 

It is a specialized processor chip installed on the motherboard that helps the CPU process the 

mathematical calculations more quickly. 

EXERCISE 

1.  Find and list various hardware and their configuration attached to your system. 

Ans: ______________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 

_______________________________________________________________________ 
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2. Find out and write down the company name, model, brief specifications and price of the 

following PC hardware. 

Hard Disk 

S.No.                Company Name Model Specifications Price 

1     

2     

3     

 

RAM 

S.No. Company Name Model Specifications Price 

1     

2     

3     

 

Motherboard 

S.No. Company Name Model  Specifications Price 

1     

2     

3     

 

Processor 

S.No. Company Name Model Specifications Price 

1     

2     

3     

 

Modem Card 

S.No. Company Name  Model Specifications Price 

1     

2     

3     
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LAB SESSION 02 

OBJECT 

Demonstration of Telecommunication Networks and identifying various network cables and their 

accessories  

THEORY 

A communications network is a collection of transmitters, receivers, and communications 

channels that send messages to one another. Some digital communications networks contain one 

or more routers that work together to transmit information to the correct user. An analog 

communications network consists of one or more switches that establish a connection between 

two or more users. 

A channel is the physical medium that carries a signal between the transmitter and the receiver. 

Examples of this include the atmosphere for sound communications, glass optical fibers for some 

kinds of optical communications, coaxial cables for communications by way of the voltages and 

electric currents in them, and free space for communications using visible light, infrared waves, 

ultraviolet light, and radio waves. This last channel is called the "free space channel". The 

sending of radio waves from one place to another has nothing to do with the presence or absence 

of an atmosphere between the two. Radio waves travel through a perfect vacuum just as easily as 

they travel through air, fog, clouds, or any other kind of gas besides air. 

Examples of Telecommunication Networks 

LAN 

WAN 

PSTN 

Satellite Networks 

Cellular Networks 

Data Transmission Media and Forms 

To get from here to there, data must move through a medium. A telephone line, a cable, or the 

atmosphere, are all transmission media, or channels. But before the data can be communicated, it 

must be converted into a form suitable for communication. The basic forms, into which data can 

be converted for communication, are as follows: 

 Electronic pulses or charges – used to transmit data over telephone lines and cables. 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

16 
 

            Media used – coaxial cables, twisted pair cables. 

 Electromagnetic Waves – used to transmit data through the air via microwave dishes and 

satellites. 

             Media used – microwave and satellite systems. 

 Light pulses – used to transmit data through glass fibers. 

             Media used – fiber optics. 

 Infrared or spread spectrum or standard radio waves – used for some newer types of wireless 

data transmission. 

Primary Cable Types 

The vast majority of networks today are connected by some sort of wire or cabling acting as a 

medium. There is a variety of cables that can meet the varying needs and sizes of networks, from 

large to small, of which three types are most commonly used: 

 Coaxial Cable 

 Twisted Pair Cable 

 Fiber Optics 

Coaxial Cables 

Coaxial cables are relatively inexpensive, light, flexible and easy to work with. They can 

transmit voice, video and data. They are more resistant to interference and attenuation than 

twisted pairs cabling. Attenuation is the loss of signal strength, which begins to occur as the 

signal travels further along a copper cable. Coaxial is a good choice for longer distances and for 

reliability supporting higher data rates with less sophisticated equipment. Television cables are 

coaxial cables. 

Composition 

In its simplest form, coaxial consist of a core made of solid copper surrounded by insulation, a 

braided metal shielding, and an outer cover. One layer of foil insulation and one layer of braided 

metal shielding is referred to as dual shielded. However, quad shielding is available for 

environments that are subject to higher interference. Quad shielding consists of two layers of foil 

insulation and two layers of braided metal shielding. Shielding protects transmitted data by 

absorbing stray electronic signals, called noise, so that they do not get onto the cable and distort 

the data 
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Types 

There are two types of coaxial cables: 

 Thinnet 

 Thicknet 

 

Figure 2.1: Coaxial Cable 

 

Connection Hardware 

Both thicknet and thinnet use connection components, known as BNC (British Naval connector 

or Bayonet Nut Connector or Bayonet Neill Concelman), to make the connection between the 

cables and the computers. There are several important components in the BNC family, including 

the following: 

 The BNC cable connector – this connector is either soldered or crimped to the end of a 

cable. 

 The BNC T connector – it joins the network interface card in the computer to the network 

cable. 
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 Figure 2.2: BNC T Connector  

 The BNC barrel connector – it is used to join two lengths of thinnet cable to make a 

longer length. 

 

 

Figure 2.3: BNC Barrel Connector 

 The BNC terminator – it closes each end of the bus cable to absorb stray signals. Without 

it, a bus network will not function. 
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Figure 2.4: BNC Terminator 

 Transceiver – it is a device that connects the thinnet coaxial to the larger thicknet coaxial 

cable. 

Twisted Pair Cables 

Twisted pair cables are used if LAN is under budget constraints and when relatively easy 

installation is required where connections are simple. 

Composition 

In its simplest form, twisted pair cable consists of two insulated strands of copper wire twisted 

around each other. A number of twisted pair wires are often grouped together and enclosed in a 

protective sheath to form a cable. The actual number of pairs in a cable varies. Twisting cancels 

out electrical noise from adjacent pairs and from other sources such as motors, relays, and 

transformers. 

There are two types of twisted pair cables: 

 Unshielded Twisted Pair (UTP) 

 Shielded Twisted Pair (STP) 

Unshielded Twisted Pair 

UTP using the 10BaseT specification is the most popular type of twisted pair cable and is fast 

becoming the most popular LAN cabling. The maximum cable length segment is 100 meters or 

about 328 feet. 

UTP consists of two insulated copper wires. Depending on the particular purpose there are UTP 

specifications, which govern how many twists are permitted per foot of cable. This is the most 

commonly used cable for existing telephone systems. 
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Figure 2.5: UTP Cable 

There are five standard categories of UTP: 

 Category 1 – this refers to traditional UTP telephone cable, which can carry voice but not 

data. Most telephone cable prior to 1983 was Category 1 cable. 

 Category 2 – this category certifies UTP cable for data transmission up to 4 Mbps 

(megabits per second). It consists of 4 twisted pairs. 

 Category 3 – this category certifies UTP cable for data transmission up to 10 Mbps.. It 

consists of 4 twisted pairs with three twists per foot. 

 Category 4 – this category certifies UTP cable for data transmission up to 16 Mbps.. It 

consists of 4 twisted pairs. 

 Category 5 – this category certifies UTP cable for data transmission up to 100 Mbps. It 

consists of 4 twisted pairs of copper wire 

The problem with UTP cable is of cross talk. Cross talk is defined as signals from one line 

getting mixed with signals from another line. Shielding is used to reduce cross talk. 

Shielded Twisted Pair 

STP uses a woven copper braid jacket, which is a high quality, more protective jacket than UTP 

has. STP also uses a foil wrap between and around the wire pair and internal twisting of the 

pairs. This gives STP excellent insulation to protect the transmitted data from outside 

interference. That is STP is less susceptible to electrical interference and supports higher 

transmission rates over longer distances than UTP. 
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Figure 2.6: STP Cable 

Connection Hardware 

Twisted pair uses two types of connectors: 

 RJ-11 – used in telephones, houses four cable connections. 

 RJ-45 - used to connect to a computer, houses four cable connections, slightly larger 

than RJ-11. The tool used to connect RJ-45 connector to the cable is called crimping 

tool. 

 

Figure 2.7: RJ-45  Connector 

Fiber Optic Cable 

In fiber optic cable, optical fibers carry digital data signals in the form of modulated pulses of 

light. This is a relatively safe way to send data because no electrical impulses are carried out over 

the fiber optic cable. This means that fiber optic cannot be tapped and the data stolen, which is 

possible with any copper based cable-carrying data in the form of electronic signals. 

Fiber optic is good for very high speed, high capacity data transmission because of the lack of 

attenuation and the purity of the signal. The fiber optic cable transmissions are not subject to 
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electrical interference. They can carry a signal, the light pulse, for miles. Therefore, these cables 

are used to transmit data at very high speeds over long distances in a very secure media. Fiber 

optic cables are pretty expensive and therefore, cannot be used under tight budget. Expertise is 

required to properly install it and connect devices to it. 

Composition 

Optical fibers consist of an extremely thin cylinder of glass, called the core, surrounded by a 

concentric layer of glass, known as the cladding. The fibers are sometimes made of plastic. 

Plastic is easier to install, but cannot carry the light pulses as far as glass. Each glass strand 

passes signals in only one direction, so a cable consists of two strands in separate jackets. One 

strand transmits and one receives. A reinforcing layer of plastic surrounds each glass strand 

while kevlar fibers provide strength. The kevlar fibers in the fiber optic connector are placed 

between the two cables, which are encased in plastic. 

 

 

Figure 2.8: Fiber Optic Cable 

EXERCISE: 

Which type of cable is used in LANs? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

Compare UTP Cable with the STP Cable. 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------
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---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

Write down the procedure of connecting the RJ-45 connector to the cable. 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

For what type of applications Singlemode fiber is used? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 
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LAB SESSION 03 

OBJECT 

Generation of commonly used signals and performing basic operations on signals 

THEORY 

MATLAB is a technical computing environment for high-performance numeric computation and 

visualization. MATLAB integrates numerical analysis, matrix computation, signal processing 

(via the Signal Processing Toolbox), and graphics into an easy-to-use environment where 

problems and solutions are expressed just as they are written mathematically, without much 

traditional programming. The name MATLAB stands for matrix laboratory. 

Data Type 

The basic data type is a complex-valued matrix. Here’s an example: 

» A = [1 2; 3 4; 5 6] 

A = 

1 2 

3 4 

5 6 

You use a space (or a comma) to separate elements in a row, and semicolons (or a linefeed) to 

separate rows. 

Suppressing the Display of Results 

MATLAB always types back the result of your command. If you don’t want to see the result you 

can type a semicolon 

at the end of the line to suppress the output for that command. 

» A = [1 2; 3 4; 5 6]; 

» 

Vector 

A vector is a special case of a matrix — a single row or a single column. 

» b = [1;2;3] 
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b = 

1 

2 

3 

» b = [1 

2 

3] 

b = 

1 

2 

3 

» c = [4 5 6] 

c = 

4 5 6 

» c = [4, 5, 6] 

c = 

4 5 6 

Scalar 

A scalar is also a special case of a matrix (1 row by 1 column) 

» d = 2 

d = 

2 

Complex numbers are written using i or j  

Note: MATLAB predefines i and j to be equal to –1 (just don’t redefine them to something else!) 

. 
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» z = 1+2i 

z = 

1.0000 + 2.0000i 

Arithmetic is performed according to matrix-vector rules 

Definition of Vectors/Signals 

MATLAB provides several commands for generating vectors. We use vectors to represent arrays 

of samples of 

signals. The following are all equivalent commands for generating a vector. 

>> x = [4 6 8 10 12 14] 

>> x = 4 + 2*[0:5] 

>> x = 4:2:14 

>> x = linspace(4,14,6) 

Getting Help 

For a list of all the available help topics, type 

>> help 

For help on a particular topic or command, such as plot type: 

>> help plot 

PROCEDURE 

Generating a signal 

% This is a program that generates a sine wave 

x=linspace(0,10*pi,200); 

% compute the signal 

y=sin(x); 

% plot the signal 

plot(y); 
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grid; 

axis([0 200 -1 1.5]) 

Adding Noise to the Signal 

x=linspace(0,10*pi,200); 

% compute the signal 

y=sin(x); 

% compute the noise 

z=0.3*rand(1,200); 

% add noise to the signal 

 Y=y+z; 

% plot the signal 

plot(Y); 

grid; 

axis([0 200 -1 1.5]) 

Here are some statements that generate several commonly used sequences, including the unit 

impulse, unit step, and unit ramp functions: 

Unit Impulse 

t = (0:0.001:1)'; 

y = [1; zeros(99,1)];  % impulse 

plot(y); 

title(‘Unit Impulse’); 

grid; 

axis([0 100 0 1])  

 

 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

28 
 

Unit Step 

t = (0:0.001:1)'; 

y = ones(100,1);  % step (filter assumes 0 initial cond.) 

plot(y); 

title(‘Unit Step’); 

grid; 

axis([0 100 0 2]) 

Ramp 

t = (0:0.001:1)'; 

y = t;  % ramp 

plot(y); 

title(‘Ramp function’); 

grid; 

EXERCISE: 

What is the purpose of linspace command? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

Write down the applications of unit step and impulse signals. 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

What is the difference between plot and stem commands? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 
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Write down the function of subplot command. 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

Define two matrices M and N and investigate the effect of the following commands: 

(a) inv(M)     (b) M*N    (c)  I=eye(2)   (d)  M(:,1)   (e)  M(2,:)   (f) N(1,1)  

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------  
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LAB SESSION 04 

OBJECT 

To establish the spectrum of Amplitude-modulated signals 

EQUIPMENT REQUIRED 

1 Module 2960A-waveform analysis 

1 Oscilloscope with external trigger facility 

1 Sine-wave oscillator, range 100 Hz to 2KHz 

1 Frequency meter, range 50Hz to 2KHz 

1 Power Supply 

THEORY 

In conventional amplitude modulation a carrier wave           is modulated by a signal s to 

produce a modulated signal                

If, as in fig 4.1, s is a sinusoidal signal, 

say              , 

then                       

                                       

Therefore, from trigonometry 

                   
 ⁄   [                       ]  

The carrier is present, and is accompanied by two sidebands, whose frequencies are separated 

either side of the carrier by the value of the signal frequency. 

PROCEDURE 

The first step is to set the frequency of the clock on the 2960A module. Push all the sliders of the 

waveform generator fully upwards and set the NORMAL/CARRIER switch to CARRIER. 

Check the waveform output with the oscilloscope. It should be a square wave, since in the carrier 

condition the output from the odd-numbered potentiometers is inverted. 

Adjust the clock control to give a frequency of 800Hz. 
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Be careful not to disturb the clock setting during the rest of the assignment. If there is any doubt, 

reconnect the frequency meter temporarily to the trigger output socket, which should produce an 

indication of 100Hz. 

OBSERVATION 

Leaving the switch set to CARRIER, now set the output of each control, measured on the 

oscilloscope as follows: 

Control 

Position 

Expected 

value(volts) 

Observed 

value(volts) 

Control 

Position 

Expected 

value(volts) 

Observed 

value(volts) 

1 -5.0  9 -5.0  

2 +6.9  10 +3.1  

3 -8.5  11 -1.5  

4 +9.6  12 +0.4  

5 -10.0  13 0  

6 +9.6  14 +0.4  

7 -8.5  15 -1.5  

8 +6.9  16 +3.1  

 

The waveform, now represents a square-wave carrier of 800Hz, 100% modulated by a sinewave 

signal of 100Hz. 

CONCLUSION 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________ 
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LAB SESSION 05 

OBJECT 

 To demonstrate amplitude-modulated signals with and without the suppression of the carrier. 

EQUIPMENT REQUIRED 

1 Double-beam oscilloscope, 5 MHz bandwidth. 

1 Low-frequency generator (0.1 Hz) 

1 Double sideband Module 2960C 

1 Power Supply 

THEORY 

Modulation 

Modulation is defined as the process by which some characteristics of a carrier signal is varied in 

accordance with a modulating signal. The base band signal is referred to as the modulating signal 

and the output of the modulation process is called as the modulation signal. 

 

Figure 5.1: Amplitude Modulation 

Amplitude modulation is defined as the process in which is the amplitude of the carrier wave is 

varied about a means values linearly with  the base band signal. The envelope of the modulating 

wave has the same shape as the base band signal provided the following two requirements are 

satisfied 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

33 
 

1. The carrier frequency fc must be much greater then the highest frequency components fm of 

the message signal m (t) i.e.   fc >> fm 

2. The modulation index must be less than unity. if the modulation index is greater than unity, 

the carrier wave becomes over modulated. 

Modulation Mathematics: 

The equation of a sinusoidal voltage waveform is given by:                 

where: 

• v is the instantaneous voltage 

• Vmax is the maximum voltage amplitude 

• ω is the angular frequency 

• φ is the phase 

Amplitude modulation uses variations in amplitude (Vmax) to convey information. The wave 

whose amplitude is being varied is called the carrier wave. The signal doing the variation is 

called the modulating signal. For simplicity, suppose both carrier wave and modulating signal 

are sinusoidal; i.e., 

            (c denotes carrier) 

and  

            (m denotes modulation) 

We want the modulating signal to vary the carrier amplitude, Vc , so that: 

                        

where             is the new, varying carrier amplitude. 

Expanding this equation and substituting m= Vm/Vc , vc can be expressed as: 

                   [           ]        [           ]  
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This expression for vc has three terms: 

1. The original carrier waveform, at frequency ωc, containing no variations and thus carrying no 

information. 

2. A component at frequency (ωc - ωm) whose amplitude is proportional to the modulation index. 

This is called the Lower Side Frequency. 

3. A component at frequency (ωc + ωm) whose amplitude is proportional to the modulation index. 

This is called the Upper Side Frequency. It is the upper and lower side frequencies which carry 

the information. This is shown by the fact that only their terms include the modulation index m. 

Because of this, the amplitudes of the side frequencies vary in proportion to that of the 

modulation signal. 

Sidebands: 

If the modulating signal is a more complex waveform, for instance an audio voltage from a 

speech amplifier, there will be many side frequencies present in the total waveform. This gives 

rise to components 2 and 3 in the last equation being bands of frequencies, known as sidebands. 

Hence we have the upper sideband and the lower sideband, together with the carrier. Clearly, for 

a given carrier amplitude there are limits for the size of the modulating signal; the minimum 

must give zero carrier, the maximum gives twice the unmodulated carrier amplitude. If these 

limits are exceeded, the modulated signal cannot be recovered without distortion and the carrier 

is said to be over-modulated. 

 

Figure 5.2: Frequency Spectrum 

 

PROCEDURE  

Plug the Module 2960C into the power supply, then switch on the supply. 

Adjust the ‘set carrier’ control to extinguish the ‘RF power monitor’ lamp. This reduces the 

transmitter’s carrier output to zero (nominally). 
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Connect the Y1 channel of the oscilloscope to the output of the 1MHz oscillator in the module. 

Set the sensitivity of this channel to 1V per division, allowing for any attenuation introduced by 

the probe. 

Set the time base to give a scale of 1µs per division, and adjust the controls so that the time base 

is triggered from the Y1 waveform. 

Set the Y2 channel to a sensitivity of 5V per division, and connect this channel to the ‘RF 

monitor’ point on the module. 

Slowly rotate the ‘set carrier’ control counter clockwise until a 1 MHz signal of approximately 

10V peak-to-peak amplitude is present at the RF monitor point (Y2 channel). Observe, and make 

a careful note of, the phase relationship between the two displayed waveforms. 

Next, slowly rotate the ‘set carrier’ control clockwise, so that the signal at the monitor point 

decreases, passes through a null and then increases once more. Set the voltage to about 10V 

peak-to-peak. Observe the phase relationship between the two waveforms in this new state, and 

make a note of your observation. 

Readjust the ‘set carrier’ control for a null output once more. Use the oscilloscope to detect the 

null precisely. Connect the low frequency generator to the ‘modulation input’ terminals. Set its 

controls to give an output of 5V peak-to-peak at 0.4Hz. Rotate the ‘set carrier’ control clockwise 

until the signal on the ‘RF monitor point’ reaches a maximum peak-to-peak value of about 15V. 

Observe the phase of the RF output changing regularly in synchronism with the modulating input 

from the oscillator. The oscillator is now having the same effect as your action on the ‘set 

carrier’ control formerly had. Raise the frequency of the oscillator to 4Hz, and you will be able 

to see the process speeded up. 

To show better how the wave is modulated, choose a very slow time-base speed, giving a scale 

of say 20ms/cm. This is the same signal as you looked at before, but on a vastly different time 

scale. Transfer the Y1 lead of the oscilloscope to the modulating oscillator. You should now 

have a display resembling fig 4.1. It may be necessary to readjust the trigger controls of the time-

base to restore the display. 

To avoid the flicker of the oscilloscope, increase the modulating frequency to 400Hz, and reset 

the time-base to 200µs/cm. The display will again resemble fig 4.1 but should be quite steady. 

Now you have a ‘double-sideband suppressed-carrier’ signal or DSSC signal. It is the result of 

simply multiplying the carrier oscillation and the modulating signal together. The product does 

not contain any carrier frequency component.  

 

 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

36 
 

OBSERVATION 

Modulating Signal 

S.No. peak-to-peak Voltage      Frequency   RMS value 

1    

2    

3    

4    

5    

 

DSSC signal                  

S.No. peak-to-peak Voltage                   Frequency RMS value                

1    

2    

3    

4    

5    

 

CONCLUSION 

----------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------- 
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LAB SESSION 06 

OBJECT: 

Demonstration of AM demodulation 

THEORY 

Modulation is defined as the process by which some characteristics of a carrier signal is varied in 

accordance with a modulating signal. The base band signal is referred to as the modulating signal 

and the output of the modulation process is called as the modulation signal. 

Amplitude modulation is defined as the process in which is the amplitude of the carrier wave is 

varied about a means values linearly with  the base band signal. The envelope of the modulating 

wave has the same shape as the base band signal provided the following two requirements are 

satisfied 

1. The carrier frequency fc must be much greater then the highest frequency components fm of 

the message signal m (t) i.e.   fc >> fm 

2. The modulation index must be less than unity. if the modulation index is greater than unity, 

the carrier wave becomes over modulated. 

 

Figure 6.1: AM Demodulation 

The process of detection provides a means of recovering the modulating Signal from modulating 

signal. Demodulation is the reverse process of modulation. 

 

PROCEDURE 

Construct an M-file and apply the following: 

Fs = 8000; % Sampling rate is 8000 samples per second. 

Fc = 300; % Carrier frequency in Hz 

t = [0:.2*Fs]'/Fs; % Sampling times for .2 second 
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x = sin(20*pi*t)+2*cos(2*pi*20*t); % Representation of the signal 

y = ammod(x,Fc,Fs); % DSB-SC signal 

figure; 

subplot(2,1,1);  

plot(t,x); % Plot x on top. 

title('Original Signal'); 

subplot(2,1,2);  

plot(t,y)% Plot y below. 

title('DSB-SC Modulated Signal'); 

% Demodulation of DSB-SC AM signal 

s1 = amdemod(y,Fc,Fs);   % Demodulate. 

figure; 

subplot(3,1,1); 

plot(t,y); 

title('DSB-SC Modulated Signal'); 

subplot(3,1,2);  

plot(t,x); 

title('Original Signal'); 

subplot(3,1,3); 

 plot(t,s1); 

title('Recovered Signal') 

EXERCISE 

1. What are the advantages of SSB over DSB Modulation? 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------
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------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

2. Follow the procedure given above and attach the output of the code. 

3. Set the sampling frequency equal to 4000 and observe the output. Write your comments. 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

4. For the input signal given in the procedure, perform SSB modulation and Demodulation 

using ssbmod and ssbdemod commands. Compare the output of the code given in the 

procedure with the output of the code that you have developed using ssbmod and 

ssbdemod commands and briefly describe the difference between the two outputs. 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

 

 

 

 

 

 

 

 

 

 

 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

40 
 

LAB SESSION 07 

OBJECT: 

 Demonstration of frequency modulation and its applications 

THEORY 

Introduction 

Frequency modulation is a process of changing the frequency of a carrier wave in accordance 

with the slowly varying base band signal. The main advantage of this modulation is that it can 

provide better discrimination against noise. 

Mathematically, an FM signal is written as:  

  

where  

A = the amplitude of the signal  

ωc = center frequency (frequency for no modulation signal)  

ωm = modulation frequency   

and   mf = FM modulation index = δ/fm 

where  δ = maximum frequency shift caused by the modulation signal  

fm = frequency of the modulation signal.  
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Figure 7.1: Frequency Modulation 

  

The main advantages of using FM over AM are: 

1. A Much better signal-to-noise ratio. There is as much as a 25-dB increase in this ratio over 

AM. You can notice this while listening to the car radio during a thunder storm. 

2. When two FM transmitters are nearby operating on the same frequency, there is a much 

smaller geographical interference area as compared to AM transmitters operating on one 

frequency. 

3. Less radiated power required for the same signal-to-noise ratio for FM over AM. 

There are also some serious disadvantages of FM. An FM wave typically requires 15 to 20 times 

the bandwith of an AM wave. Also, FM systems are much more complicated to analyze and 

build than AM systems. 

 

 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

42 
 

Applications of FM 

FM is used in the following applications: 

 Non-commercial broadcasting from 88 – 90 MHz (WFM) 

 Commercial broadcasting from 90 – 108 MHz (WFM) 

 Television audio (WFM) 

 Public Service communications (police, fire departments, etc.) from 30 – 50 MHz, 136-

174 MHz, 450-470 MHz, and 800 MHz (NBFM) 

 Amateur Radio Service Communications 

 Point-to-point microwave links used by telecommunications companies 

PROCEDURE 

Construct an M-file and apply the following: 

Fs = 8000;                % Sampling rate is 8000 samples per second. 

Fc = 300;                 % Carrier frequency in Hz 

t = [0:.2*Fs]'/Fs;      % Sampling times for .2 second 

x = sin(20*pi*t)+2*cos(2*pi*20*t);    % Representation of the signal 

dev=50; 

y = fmmod(x,Fc,Fs,dev); 

subplot(2,1,1) 

plot(t,x); 

subplot(2,1,2) 

plot(t,y); 

EXERCISE 

1. Run the given code in MATLAB and attach the print out of the plots that you obtain.  

2. Set the Carrier frequency to 500 Hz and observe the output. What is the effect of 

increasing the Carrier frequency? 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

3. Set the carrier frequency to 300 Hz and change the frequency deviation to 30. What is the 

effect of decreasing the frequency deviation? 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

43 
 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

4. Attach the print out of the plots that you have obtained. 
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LAB SESSION 08 

OBJECT: 

Demonstration of FM Demodulation 

THEORY 

Demodulation 

Demodulation is the act of extracting the original information-bearing signal from a modulated 

carrier wave. A demodulator is an electronic circuit (or computer program in a software-defined 

radio) that is used to recover the information content from the modulated carrier wave. 

Types of FM Demodulator 

There are several common types of FM demodulator: 

The quadrature detector, which phase shifts the signal by 90 degrees and multiplies it with the 

unshifted version. One of the terms that drops out from this operation is the original information 

signal, which is selected and amplified. 

The signal is fed into a PLL and the error signal is used as the demodulated signal. 

The most common is a Foster-Seeley discriminator. This is composed of an electronic filter 

which decreases the amplitude of some frequencies relative to others, followed by an AM 

demodulator. If the filter response changes linearly with frequency, the final analog output will 

be proportional to the input frequency, as desired. 

A variant of the Foster-Seeley discriminator called the ratio detector  

Another method uses two AM demodulators, one tuned to the high end of the band and the other 

to the low end, and feed the outputs into a difference amp. 

Using a digital signal processor, as used in software-defined radio. 

PROCEDURE 

Construct an M-file and apply the following: 

Fs = 8000;                                            % Sampling rate is 8000 samples per second. 

Fc = 300;                                              % Carrier frequency in Hz 

t = [0:.2*Fs]'/Fs;                                   % Sampling times for .2 second 

x = sin(20*pi*t)+2*cos(2*pi*20*t);    % Representation of the signal 
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dev=50; 

y = fmmod(x,Fc,Fs,dev); 

z=fmdemod(y,Fc,Fs,dev); 

subplot(3,1,1) 

plot(t,x); 

subplot(3,1,2) 

plot(t,y); 

subplot(3,1,3); 

plot(t,z) 

EXERCISE  

1. Run the given code in MATLAB and attach the print out of the plots that you obtain. 

2. Which is the most widely used type of FM demodulator? 

 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

------------------------------------------------------------------------------------------------------------ 

3. What is PLL ? Draw the block diagram of PLL FM Demodulator. 

 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 
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LAB SESSION 09 

OBJECT 

To be familiar with the basic structure and applications of Optical Fiber Cable. 

EQUIPMENT 

• Light Source 

• Cable #3 

• Cable #4 

• Cable #5 

THEORY 

An optical fiber (or fibre) is a glass or plastic solid rode that carries light along its length with the 

help of the total internal reflection.It consists of core and cladding. The refractive index of the 

core is greater than the cladding.  

 

Figure 9.1: Optical Fiber 

They can be either single mode or multi-mode fibers. 

Multi-mode Fiber: 

Fiber with large core diameter (greater than 10 micrometers) may be analyzed by geometric 

optics. Such fiber is called multi-mode fiber, from the electromagnetic analysis In a step-index 

multi-mode fiber, rays of light are guided along the fiber core by total internal reflection. Rays 

that meet the core-cladding boundary at a high angle (measured relative to a line normal to the 

boundary), greater than the critical angle for this boundary, are completely reflected. The critical 
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angle (minimum angle for total internal reflection) is determined by the difference in index of 

refraction between the core and cladding materials. Rays that meet the boundary at a low angle 

are refracted from the core into the cladding, and do not convey light and hence information 

along the fiber. The critical angle determines the acceptance angle of the fiber, often reported as 

a numerical aperture. A high numerical aperture allows light to propagate down the fiber in rays 

both close to the axis and at various angles, allowing efficient coupling of light into the fiber. 

However, this high numerical aperture increases the amount of dispersion as rays at different 

angles have different path lengths and therefore take different times to traverse the fiber. A low 

numerical aperture may therefore be desirable. 

In graded-index fiber, the index of refraction in the core decreases continuously between the axis 

and the cladding. This causes light rays to bend smoothly as they approach the cladding, rather 

than reflecting abruptly from the core-cladding boundary. The resulting curved paths reduce 

multi-path dispersion because high angle rays pass more through the lower-index periphery of 

the core, rather than the high-index center. The index profile is chosen to minimize the difference 

in axial propagation speeds of the various rays in the fiber. This ideal index profile is very close 

to a parabolic relationship between the index and the distance from the axis. 

 

 

Figure 9.2: Multimode and Single Mode Fiber 

Single mode Fiber: 

The most common type of single-mode fiber has a core diameter of 8–10 micrometers and is 

designed for use in the near infrared. The mode structure depends on the wavelength of the light 

used, so that this fiber actually supports a small number of additional modes at visible 

wavelengths. Multi-mode fiber, by comparison, is manufactured with core diameters as small as 

50 micrometers and as large as hundreds of micrometres. The normalized frequency V for this 

fiber should be less than the first zero of the Bessel function J0 (approximately 2.405). Single 

mode fiber has the least dispersion and hence are used for longer distances. 
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Uses of Fiber Optic Cables 

Fiber optic cables find many uses in a wide variety of industries and applications. Some uses of 

fiber optic cables include: 

Medical 

Used as light guides, imaging tools and also as lasers for surgeries 

Defense/Government 

Used as hydrophones for seismic and SONAR uses, as wiring in aircraft, submarines and other 

vehicles and also for field networking 

Data Storage 

Used for data transmission 

Telecommunications 

Fiber is laid and used for transmitting and receiving purposes 

Networking 

Used to connect users and servers in a variety of network settings and help increase the speed 

and accuracy of data transmission 

Industrial/Commercial 

Used for imaging in hard to reach areas, as wiring where EMI is an issue, as sensory devices to 

make temperature, pressure and other measurements, and as wiring in automobiles and in 

industrial settings 

Broadcast/CATV 

Broadcast/cable companies are using fiber optic cables for wiring CATV, HDTV, internet, video 

on-demand and other applications 

PROCEDURE AND OBSERVATION 

Connect the given optical fiber with the light source and observe the light patters and the 

diameter of the fiber. 

Cable #3 is ……………………………………………. 

Cable #4 is ……………………………………………. 

Cable #5 is ……………………………………………. 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

49 
 

CONCLUSION 

----------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------- 

EXERCISE 

1. What is the difference between step index fiber and graded index fiber? 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

 

2. What type of losses occur when light travels through an optical fiber cable? 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

3. Write down the applications of Single mode and Multimode Fibers. 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 
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LAB SESSION 10 

OBJECT: 

Introduction to Microwave Communication and Identification of different waveguide 

components 

EQUIPMENT: 

Wave-Guide (mod.MW-2 I mod.MW-3) 

WG/COAX adapter (mod.MW·1) 

Slotted Line (mod.MW-5) 

BNC-SMA detector (mod. MW-4) 

Coaxial Attenuator (mod.MW-23) 

Matched Load Termination (mod.MW-9) 

Short-Circuit (mod.MW-10) 

Variable Attenuator (mod.MW-6) 

THEORY: 

Microwave transmission refers to the technology of transmitting information or energy by the 

use of radio waves whose wavelengths are conveniently measured in small numbers of 

centimetre; these are called microwaves. This part of the radio spectrum ranges across 

frequencies of roughly 1.0 gigahertz (GHz) to 30 GHz. These correspond to wavelengths from 

30 centimeters down to 1.0 cm. 

Microwave Communication 

Microwave communication is the transmission of signals via radio using a series of microwave 

towers. Microwave communication is known as a form of "line of sight" communication, 

because there must be nothing obstructing the transmission of data between these towers for 

signals to be properly sent and received. 

The technology used for microwave communication was developed in the early 1940's by 

Western Union. The first microwave message was sent in 1945 from towers located in New York 

and Philadelphia. 
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Microwave link 

A microwave link is a communications system that uses a beam of radio waves in the microwave 

frequency range to transmit video, audio, or data between two locations, which can be from just 

a few feet or meters to several miles or kilometers apart. Microwave links are commonly used by 

television broadcasters to transmit programmes across a country, for instance, or from an outside 

broadcast back to a studio. 

Mobile units can be camera mounted, allowing cameras the freedom to move around without 

trailing cables. These are often seen on the touchlines of sports fields on Steadicam systems. 

 

 

Figure 10.1: Block Diagram of Microwave Transmitter and Receiver 

 

Figure 10.2: Microwave Link 

Properties of microwave links 
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Involve line of sight (LOS) communication technology 

Affected greatly by environmental constraints, including rain fade 

Have very limited penetration capabilities through obstacles such as hills, buildings and trees 

Sensitive to high pollen count 

Signals can be degraded during Solar proton events 

Uses of microwave links 

 In communications between satellites and base stations 

 As backbone carriers for cellular systems 

 In short range indoor communications 

 Telecommunications, in linking remote and regional telephone exchanges to larger 

(main) exchanges without the need for copper/optical fibre lines. 

PROCEDURE 

There are many components designed for operation at microwave frequencies. Some of these 

components are: 

WG/COAX adapter (mod.MW·1) 

The Wave-guide to Coaxial adapter or "WG to Coax" is used to convert the electromagnetic field 

(E-H) present in the wave-guide into electrical signal in the coaxial cable. Obviously its function 

is performed in both directions, so also from electrical signal to electromagnetic field. See Figure 

10.3. The commonly available adapters are set for the excitation of the electrical fields inside the 

wave-guide: this occurs introducing a conductor inside the guide (Figure 10.4), at a distance of 

λg/4 (λg is the wave-length in the guide) from the rear side, so that the reflected and the incident 

waves are in phase. Even the height X is about λg/4 and each component is singularly matched 

for the best performances. Our adaptor is Coaxial cable kind: SMA-female, VSWR: 1.25 max 
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Figure 10.3 

Wave-Guide (mod.MW-2 I mod.MW-3) 

The "wave-guide" is more properly called "WG Straight section". It is used as a transmission line 

and there are rigid or flexible versions of different kind, that enable the transferring of the 

electromagnetic field inside it. Important characteristics are low loss and VSWR. Our system 

uses three rigid and straight ones with the following characteristics, Figure 10.4 

 

Figure 10.4 

Slotted Line (mod.MW-5) 

It is a device used to detect the standing wave inside the guide (Figure 10.5). The Detector 

(mod.MW-4) must be used and is screwed on the upper part of the trailer that slides along the 

slot of the wave-guide. The voltage provided by the detector is proportional to the amplitude of 

the standing wave in the different positions along the line. 
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Figure 10.5 

BNC-SMA detector (mod. MW-4) 

Inside, the detector is characterized by the following components 

• Input RF matching impedance DC Return 

• RF by-pass capacitor 

• Detector diode (with negative polarity) 

The input of the detector is designed to match the signal that is to be analyzed on 50 Ohm. The 

DC output is commonly called Video output. 

Coaxial Attenuator (mod.MW-23) 

The coaxial attenuator is a passive component inserted into a metal container (see Figure). The 

input and the output use the SMA coaxial connector and are matched on 50ohm. Its function is to 

attenuate the level of the RF signal to the input of 20dB. In particular, 20 dB corresponds to 

attenuation equal to: 

• 100 times in power, and 

• 10 times in voltage 

If the attenuator is used, e.g., across the output of an amplifier stage, the total output level after 

the attenuator will be reduced of 20 dB, if it is expressed in dBm (measurement unit of the power 

referred to ImW) as well as in dBJ.l (measurement unit of the voltage referred to IJ.lV). 

The attenuator is used when in presence of strong signals that could damage the next circuit, 

saturate the states of a receiver or a meter or when it is necessary for the signal level to be inside 

a fixed level range. 
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Figure 10.6                             Figure 10.7 

Matched Load Termination (mod.MW-9) 

The termination or fictitious load, is a device absorbing the RF power without causing reflections 

(Figure 10.7). It consists of a WG straight section of wave-guide closed in short-circuit, with 

absorbing material (for the RF) that starts from the short-circuit and restricts to the open side. 

The particular shape with triangular section enables the gradual and complete absorption of the 

incident power to prevent reflections. Important characteristic is the low VSWR. 

 

Figure 10.7 

Short-Circuit (mod.MW-10) 

It is short-circuit termination for wave-guide. It uses the completely closed standard flange that 

causes the complete reflection of the whole incident RF signal. See Figure 

 

Figure 10.8 
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EXERCISE 

1. How many types of microwave waveguides are there? Define each type. 

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 

2. What are the advantages of Microwave Communication? 

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 

3. Which type of antenna is best suited for Microwave Communication? 

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 
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LAB SESSION 11 

OBJECT 

Generation of signals and observing the effect of noise on the signals 

PROCEDURE: 

Building a Simple Model 

The model integrates a sine wave signal and displays the result along with the original signal. 

Before creating a model, you need to start MATLAB and then start Simulink. 

1 In the MATLAB Command Window, enter Simulink The Simulink Library Browser opens. 

2 From the Simulink Library Browser menu, select File > New > Model. 
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A Simulink editor window opens with an empty model. 

  

3 Select File > Save as. The Save As dialog box opens. 

4 In the File name box, enter a name for your model, and then click Save. 

For example, enter simple_model. 

1 In the Simulink Library Browser, select the Sources library. 
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2 Select the Sine Wave block, and then drag it to the editor window. 

A copy of the Sine Wave block appears in your model. 
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3 Similarly, add the following blocks to your model in the same way you added the 

Sine Wave block. 

Library    Block 

Sinks     Scope 

Continuous    Integrator 

Signal Routing  Mux 

 

Move the Scope block after the Mux block output.  

 Move the Sine Wave and Integrator blocks before the Mux block Inputs. 

Your model should look similar to the following figure. 



Workbook for the Course TC-101    Department of Electronic Engineering            

Fundamentals of Telecommunications Engineering                           

 

61 
 

 

After you add blocks to your model, you need to connect them. The connecting 

lines represent the signals within a model. 

Most blocks have angle brackets on one or both sides. These angle brackets 

represent input and output ports: 

• The > symbol pointing into a block is an input port. 

• The > symbol pointing out of a block is an output port. 

Click and drag a line from the output port to the top input port of the Mux block. 

While you hold the mouse button down, the connecting line appears as a dashed line. 
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Release the mouse button over the output port. 

Drag a line from the output port of the Integrator block to the bottom input port on the Mux 

block. 

The Integrator block connects to the Mux block with a signal line. 

5 Select the Mux block, hold down the Ctrl key, and then select the Scope block. 

A line is drawn between the blocks to connect them. Your model should now look similar to the 

following figure. 
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Connect the Sine Wave block to the Integrator block. 

Because the output port of the Sine Wave block is already connected, you must connect this 

existing line to the input port of the Integrator block. The new line, called a branch line, carries 

the same signal that passes from the Sine Wave block to the Mux block. 

1 Position the mouse pointer on the line between the Sine Wave and the Mux block. 

2 Hold down the Ctrl key, and then drag a line to the input port of the Integrator block input port. 

3 From the File menu, click Save. Your model is now complete. 
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In the Simulink editor window, select Simulation > Start from the menu. 

Double-click the Scope block. The Scope window opens and displays the simulation results. The 

plot shows a sine wave signal with the resulting cosine wave signal from the Integrator block. 
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Generating a signal and adding Noise to the signal 

1. Click the + sign next to Signal Processing Blockset in the left pane of the Library 

Browser. This displays a list of the Signal Processing Blockset libraries. 

2. Click DSP Sources in the left pane. This displays a list of the DSP Sources library 

blocks in the right pane. If you do not see the Sine Wave block, scroll down the list 

until it is visible. 

3. Click the Sine Wave block and drag it into the model window. 

4. Click DSP Sinks in the left pane of the Library Browser. 

5. Scroll down in the right pane of the Library Browser until you see the Vector Scope 

block, and drag the block into the model window to the right of the Sine Wave block. 

Once a block is in the model window, you can move it to another position by dragging the 

block with the mouse. 
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Connecting Blocks 

The small arrowhead pointing outward from the right side of the Sine Wave block is an output 

port for the data the block generates. The arrowhead pointing inward on the Vector Scope 

block is an input port. To connect the two blocks, click the output port of the Sine Wave block 

and drag the mouse toward the input port of the Vector Scope block, as shown in the 

following figure. 

 

When the pointer is on the input port of the Vector Scope block, release the mouse button. 

You should see a solid arrow appear, as in the following figure. 
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If you do not see a solid arrowhead, you have not made a connection. In this case, click the 

arrowhead again, drag it all the way to the Vector Scope's input port, and release the mouse 

button. 

Setting Block Parameters 

To set parameters for the Sine Wave block, double-click the block to open its dialog, as 

shown in the following figure. Change the following parameters by clicking in the field next to 

the parameter, deleting the default setting, and entering the new setting in its place: 

1. Set Amplitude to 5. 

2. Set Frequency to 30. 

3. Set Samples per frame to 100. 

4. Click OK. 

Dialog for the Sine Wave Block 
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Setting Simulation Parameters 

Besides individual block parameters, the model also has overall simulation parameters. To 

view the current settings, 

1. Select the Simulation menu at the top of the model window. 

2. Select Configuration parameters to open the Configuration Parameters dialog 

box, as shown in the following figure. 

 

Configuration Parameters Dialog Box 

 

If you typed commstartup before creating the model, the Stop time should be set to inf. The 

Stop time determines the time at which the simulation ends. Setting Stop time to inf causes 

the simulation to run indefinitely, until you stop it by selecting Stop from the Simulation 

menu. 

The Stop time is not the actual time it takes to run a simulation. The actual run-time for a 

simulation depends on factors such as the model's complexity and your computer's clock 
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speed. 

The settings in the Configuration Parameters dialog box affect only the parameters of the 

current model. 

Running the Model 

Run the model by selecting Start from the Simulation menu. When you do so, a scope 

window appears, displaying a sine wave as shown in the following figure. 

 

 

Sine Wave Displayed in a Scope 

 

Adding Noise to the Model 

You can add noise to the model using the AWGN Channel block, from the Channels library of 

the Communications Blockset. The block adds white Gaussian noise to the sine wave. Move 

the block from the Simulink Library Browser into the model window, as described in Moving 
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Blocks into the Model Window. You can add the block to the model as follows: 

1. Extend the line between the Sine Wave block and the Vector Scope block by 

dragging the Vector Scope block to the right, to make room for the AWGN Channel 

block. 

2. Click the AWGN block and drag it onto the line. This automatically connects the Sine 

Wave block and the Vector Scope block to the AWGN Channel block. 

 

Sine Wave Plus Noise 

 

Double-click the AWGN Channel block to open its dialog, as shown in the following figure. 

 

Then, click the down arrow in the Mode field and select Signal to noise ratio (SNR).                                                     

Dialog for the AWGN Channel Block 
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Now when you run the model, the scope clearly shows the added noise. 

OBSERVATION 

Sine Wave with Noise Added 

 

When you are finished observing the simulation, stop the model by selecting Stop from the 

Simulation menu. 

What did you observe? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 

Select an input signal of your own choice and repeat the procedure. What is the effect of noise on 

this signal? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------  
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EXERCISE 

1. What are the advantages of simulation and modeling? 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------                  

2. Build the models given in the procedure and attach the screenshot of the model and its 

output.           

   

3. Using Simulink 

i. Amplify a sine wave using gain block 

ii. Integrate step function 

iii. Mention the library or sub-library in which these blocks are present 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------                                    

Note: Attach the screenshots of the Simulink models of Q.no. 3. 


